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Before Using This Manual

The following manual explains various statistical methods using tutorials. Each tutorial begins
with a problem that is based on a set of data. A solution is then presented as an example of the
steps that need to be taken to perform that particular statistical method.

In using these tutorials, you need to be able to access the various data sets that are used. To
access these files, it is easier to copy the files to your home directory.

1. Logon to an x server from your Polaris account.

2. Inyour home directory, make a directory called SPSS.
> nkdi r SPSS

3. Open up a Netscape browser.

4. Change the location in the browser to where the files are located. The address is:
http://setosa.uwaterloo.ca/Stats_Dept/StatSoftware/Datafiles/SPSS/

5. Position the cursor so that it is located on top of one of the data files in this directory. Hold
down the Shift button and left click. The Save As... window will appear.

6. Choose the directory, ~/SPSS.

7. If you are using a browser from UNIX, ensure that the Format For Saved Document: box
indicates Source. DO NOT save as Text or Postscript.
However, if you are using Netscape in Polaris, ensure that the type of file to save as is HTML
Files and change the ending of the file to .htm. This will ensure that the file is saved in the
correct format.

8. Click OK. This will download the selected file into ~/SPSS.

9. For all other files shown, repeat steps 5-8 until all files have been saved to ~/SPSS.

At this point, all data files to be used in this manual should be in the directory ~/SPSS. If you are

accessing SPSS from your Polaris account, you would look under the P: drive to find this

directory.

A description and patrtial listing of the data sets are located in Appendix A.



Introduction to SPSS

SPSS (Statistical Package for the Social Sciences) is a statistical analysis and data management
software package. SPSS can take data from almost any type of file and use them to generate
tabulated reports, charts, and plots of distributions and trends, descriptive statistics, and conduct
complex statistical analyses.

The following manual will give an introductory description of how to use SPSS. However, due to
the complex nature of SPSS, many details have been omitted. To find a more complete
description, consult the following manuals:

SPSS Guide by Kilman Shin
Some helpful websites concerning SPSS are:

www.cofc.edu/academic/admin/acomp/Guides/spss.html
WWW.SPSS.com
www.leeds.ac.uk/ucs/docs/begl4/begl4.html
www.nyu.edu/acf/pubs/SPSS Win/SPSSwindoc_ToC.html
www.indiana.edu/~statmath/smdoc/index.html




SPSS Basics

> Tutorial 1: SPSS Windows

There are six different windows that can be opened when using SPSS. The following will give
a description of each of them.

The Data Editor

The Data Editor is a spreadsheet in which you define your variables and enter data. Each row
corresponds to a case while each column represents a variable. The title bar displays the
name of the open data file or "Untitled" if the file has not yet been saved. This window opens
automatically when SPSS is started.
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The Output Navigator

The Output Navigator window displays the statistical results, tables, and charts from the
analysis you performed. An Output Navigator window opens automatically when you run a
procedure that generates output. In the Output Navigator windows, you can edit, move,
delete and copy your results in a Microsoft Explorer-like environment.

i Outputl - SPSS Dutput Navigator
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The Pivot Table Editor

Output displayed in pivot tables can be modified in many ways with the Pivot Table Editor.
You can edit text, swap data in rows and columns, add color, create multidimensional tables,
and selectively hide and show results.

The Chart Editor

You can modify and save high-resolution charts and plots by invoking the Chart Editor for a
certain chart (by double-clicking the chart) in an Output Navigator window. You can change
the colors, select different type fonts or sizes, switch the horizontal and vertical axes, rotate
3-D scatterplots, and change the chart type.

The Text Output Editor

Text output not displayed in pivot tables can be modified with the Text Output Editor. You can
edit the output and change font characteristics (type, style, color, size).

The Syntax Editor

You can paste your dialog box selections into a Syntax Editor window, where your selections
appear in the form of command syntax.

» Tutorial 2: Starting A SPSS Session

1. Logon to your Polaris account.

2. Select Programs from the Start menu.

3. Select Scientific from the Programs drop down menu.

4. Select SPSS 7.5 from the Scientific drop down menu.
» Tutorial 3: Getting Help on SPSS

O Locating Topics in the Help Menu

1. Select Topics from the Help Menu on the Data Editor.

2. Select the Cont ent s tab. This will give a set of books to look under for the required
information.

O Searching for Information in the Help Menu
1. Select Topics from the Help menu.
2. Select the Index tab.

3. Type a word in the text box describing the information to search for. This will give a list of
headings on the desired information.

» Tutorial 4. Ending A SPSS Session

1. Select Exit SPSS from the File menu on the Data Editor.



Creating and Manipulating Data in SPSS

When creating or accessing data in SPSS, the Data Editor window is used.

» Tutorial 1: Creating a New Data Set

There are three steps that must be followed to create a new data set in SPSS. The following
tutorial will list the steps needed and will give an example of creating a new data set.

STEP 1: Defining Variables in a New Data Set

Variables are defined one at a time using the Define Variable dialog box. This box assigns
data definition information to variables. To access the Define Variable dialog box, double-
click on the top of a column where the word var appears or select Define Variable from the

Data menu.

Define Variable

Wariable Mamne:

—Wariable Description
Tupe: Mumericd. 2
Yariable Label:
Mizsing Y alues:
Alignment:

MNone
Right

0K

o |
Cancel |
[

Help

— Change Settings

Type... | Migsing Values. .. |

Labels.. | Column Format. .. |

Variable Name: This field describes the name of the variable being defined. To change the

name, place the cursor in this field and type the name. The variable name
must begin with a letter of the alphabet and cannot exceed 8 characters.
Spaces are not allowed within the variable name. Each variable name must
be unique.

Type: This field describes the type of variable that is being defined.
To change this field, click on the Type... button. This will open the Define Variable
Type: dialog box. Select the appropriate type of data. When done, click on the Continue

button.

Define Yariable Type:

" Dot

' Scientific notation

" Date
" Dallar

€ Custom curency

" Sting

Ll IS_ Cancel |
_tee |

Decimal Places: |2_ Hel
elp

Variable Label: There are two types of variable labels:

1. Variable Label: A name for the variable that can be up to 120 characters
long and can include spaces (which variable names cannot). If a variable
label is entered, the label will be printed on charts and reports instead of
the name, making them easier to understand.



2. Value Label: Provides a key for translating numeric data.

To change the variable label, click on the Labels... button. This will open the
Define Labels: dialog box. Enter the appropriate information into the fields.
When done, click on the Continue button.

Define Labels: %]
Wariable Label: I Continue I
Walue Label Cancel |
Walue: Hel
elp |
Walue Label:
Al
[Ehatge |
Hemowve |

Missing Values:

This field indicates which subset of the data will not be included in the data

set. To change this field, click on the Missing Values... button. This will
open the Define Missing Values: dialog box. Enter the appropriate
information into the fields. When done, click on the Continue button.

Define Missing Values: | X|

" Discrete missing values

" Bange of missing values

Cancel |
Help |

Lo I Hiahs I

" Range plus one discrete missing valus

Hih |

[izerete valie; I

1Lt I

Alignment: This field indicates column alignment and width. To change this field, click on the
Column Format... button. This will open the Define Column Format: dialog box.
Enter the appropriate information into the fields. When done, click on the

Continue button.

Define Column Format: E3

Column *wfidth: IE

Text &lignment
’7(" Left € Center (' Right

Cancel |

Help |

STEP 2: Entering Data in a New Data Set

Once all of the variables are defined, enter the data manually (assuming that the data is not
already in an external file). The data is typed into the spreadsheet one cell at a time. Each

cell represents an observation.

When information is typed into a cell, it appears in the edit area at the top of the window. The
information is entered into the cell when the active cell is changed. The mouse and the tab,
enter, and cursor keys can be used to enter data.

To indicate a cell that does not have a data value, a period is entered. A period represents

the system-missing value.



STEP 3: Saving a New Data Set

Work performed on a data set only lasts during the current session. To retain the current data
set, it must be saved to a file.

1. Select Save from the File menu. The Save Data As dialog box opens.
2. From the Save as Type drop-down list, select SPSS (*.sav).
3. From the Save in drop-down list, select the path where the file will be saved.

4. In the File name box, enter a name for the file. SPSS automatically adds the extension

.sav.
5. Click Save.
Problem

The following data regarding a person’s name, age and weight must be entered into a data
set using SPSS.

Name Age Weight
Mark 39 250

Allison 43 125
Tom 27 180
Cindy 24 130

Solution

1. Double click on the top of the first column in the Data Editor window. This will open the
Define Variable dialog box. Type Name in the Variable Name box.

2. Select Type... in the Change Settings area. This will open the Define Variable Type
dialog box. Left click on String.

3. Select Continue. This will close the Define Variable Type dialog box and will re-open the
Define Variable dialog box.

4. Click OK. This will define the first column as a string variable called Name.

5. Double click on the top of the second column. This will open the Define Variable dialog
box. Type Age in the Variable Name box.

6. Select Type... in the Change Settings area. This will open the Define Variable Type
dialog box. Left click on Numeric. In the Width box, set it to 3. In the Decimal Places box,
setitto 0.

7. Select Continue. This will close the Define Variable Type dialog box and will re-open the
Define Variable dialog box.

8. Click OK. This will define the second column as a numeric variable called Age.

9. Double click on the top of the third column. This will open the Define Variable dialog box.
Type Weight in the Variable Name box.



10. Select Type... in the Change Settings area. This will open the Define Variable Type
dialog box. Left click on Numeric. In the Width box, set it to 3. In the Decimal Places box,
setitto 0.

11. Select Continue. This will close the Define Variable Type dialog box and will re-open the
Define Variable dialog box.

12. Click OK. This will define the third column as a numeric variable called Weight.

13. Enter the above information into the cells of the spreadsheet. The Data Editor should look
like the following.

Untitled - SP55 Data Editor [ [=] B3
File Edit “iew Data Transform  Statistice Graphs  Utiliies  Window Help
S@(8| = of 1] (0| ) ] Ds|E sl
| &
name age weight var var var var var|
1 | Mark 349 250
2 | Allison 43 125
3| Tom 27 180
4 | Cindy 24 130
5
6
7
<] o
|SPSS Processor is ready | | v

14. Select Save from the File menu.
15. Choose the path where the file will be saved.

16. Type temp in the File name box and click Save. SPSS will save this file as temp.sav in
the specified directory.

Tutorial 2: Creating a New Data Set From Other File Formats
SPSS is designed to handle a wide variety of formats including:

Spreadsheet files created with Lotus 1-2-3 and Excel
Database files created with dBASE

Tab-deliminated and other types of ASCII text files
SPSS data files create on other operating systems
SYSTAT data files

The following tutorial will indicate how to read in a spreadsheet or text file into a data set in
SPSS. Examples will be given of each method.
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O Reading Spreadsheet Files (Lotus 1-2-3 and Excel)

Problem

Read the following file, ~/SPSS/nba.xls, into a SPSS data set.

Solution
1. From the File menu, select Open. This will open the Open File dialog box.
2. Change the path name to your home directory and open the SPSS folder. This is
where the file to be opened should be.
3. Select Excel(*.xIs) (or Lotus(*.w*) for Lotus files) from the Files of type box.
Dpen File l
Laoak in: I@SDSS j gl e
nba.xls
File name: Open I
Files of type: Paste |
Cancel |
4. Select nba.xls.
5. Click Open. This will open the Opening File Options dialog box. Click on the Read

variable names dialog box. Click OK. This will close the Opening File Options dialog
box and will open nba.xls in the Data Editor. The Output Navigator will also be
opened.

Dpening File Options
P:45P554nba.xls

NOTE:
If only a partial file is to be read into SPSS, the following steps are taken.

For Lotus files, in the Range box, specify the beginning column letter and row
number followed by two periods followed by the ending column letter and row
number. le. A1..C12
For Excel files, in the Range box, specify the beginning column letter and row
number followed by a colon followed by the ending column letter and row
number. le. A1:C12

11



Window Output

Untitled - SP5S Data Editor =] B3
File Edit “iew Data Transform  Statistics Graphs  Utilities  Window Help

SR8 B | L (o] o) £l Sl sl

1:player ‘ﬂ ﬂ
player height weight var var var var

1 1 73 162

2 2 a1 225

3 3 go 241

4 4 73 190
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6 G 7 205

7 7 a0 250
il_ln a a2 20 _}ILI
|SPSS Processor is ready | | v

utput1 - SP55 Dutput Navigator
File Edit “iew |ngert Fornat  Statistic: Graphs  Utities  window  Help

S8R B B o @2 @ & |
<131 (= mim) zl=lE]

=-+{E] sPsSS output
- @ SPSS Log
Data written to the working file.
3 wvariables and 411 cases written.
Varishle: PLAYER Type: Nuwbher Format: F9
Varisble: HEIGHT Type: Nuwber Format: F9
Varisble: WEIGHT Type: Nuwber Format: F9
« | 2

Double click to edit Log [® [5P55 Processar is ready | [H:121 wh 4680 gt




O Reading Text Files
Two ways to read a text file are by using freefield or fixed columns.
Freefield

This method is used if the variables are recorded in the same order for each case but not
necessarily in the same column locations.

Problem
Read the following file, ~/SPSS/citydata.txt, into an SPSS data set.
Solution

1. Select Read ASCII Data from the File Menu. From the Read ASCII Data drop down
menu, choose Freefield. This will open the Define Freefield Variables dialog box.

i Define Freefield Yariables
File:
I 4 |
|
! Easte |
M ame: I Beset
Defined W ariables: ﬂl
P T Cancel |
& Mumeric
Hel
' Stiing il
width:ls

Add

[Ehange |
[

Hemove

V¥ Dizplay warning message for undefined data

2. Specify the variable name and data type. The following gives a description of each of
these fields.

Name: Variable names must begin with a letter and cannot exceed eight characters.
Each variable name must be unique.

Data Type: Select a data type.

3. Click Add for each separate variable. This will enter the variable name and data type
onto the Defined Variables list.

4. Once all variables are defined, click Browse to specify the name of the file to be read.
This will open the Define Freefield Variables: Browse dialog box. Change the path
name to your home directory and open the SPSS folder. This is where the file to be
opened should be.

5. Select citydata.txt and click Open. The Define Freefield Variables dialog box will be
returned.

6. Click OK. This will close the Define Freefield Variables dialog box and will open
citydata.txt in the Data Editor.

13



Window Output

Untitled - 5P55 Data Editor

File Edit “iew Data Transform  Statistics Graphs  Utilities  Window Help

M[=F3

SR8 B | L (o] o) £l Sl sl

1:city ‘ﬂ ﬂ

city steak milk coke rent house phone gas

1 1.00 5.64 1.58 1.39 556.00 125750.0 24.02 1

2 2.00 5.97 1.46 1.16 410.00 123450.0 22.06 1

3 3.00 4.46 1.43 1.2 410.00 107342.0 23.10 1

4 4.00 5.93 1.35 1.058 455.00 113520.0 23.07 1

5 5.00 5.67 1.42 1.1 426.00 116125.0 1787 1

6 5.00 5.06 1.45 1.1 459.00 102433.0 22.85 1

7 7.00 5.83 1.49 1.16 506.00 110000.0 18.43 1
il—lﬁ a00 R 42 200 189 Fa000 18R0R1 1 14 43 _:ILI
|SPSS Processor is ready | v

Fixed Columns

This method is used if each variable is recorded in the same column location for each

case in the data file.

Problem

Read the following file, ~/SPSS/nba.txt, into an SPSS data set.

Solution

1. Select Read ASCII Data from the File Menu. From the Read ASCII Data drop down
menu, choose Fixed Columns. This will open the Define Fixed Variables dialog box
which will be used to define each variable.

+ Define Fized Yariables

i~ File:
|
|

;8

Baste

MHame: I
|1_
Start Colurm: I
I_
Data Type

123=123,1.23=1.23

Record:

End Calumn:

I Mumeric as is j

Defined Yariables:

Eeset

Cancel

elilel |

Help

Lidd | Qhangel Fiemovel

Walue Azzigned ta Blanks for Mumeric W ariables
W alue: I

’7(3' Systemn mizsing

V¥ Display surmmary table

V' Display waming message for undefined data

2. Specify the variable name, record, column locations, and data type. The following
gives a description of each of these fields.

Name: Variable names must begin with a letter and cannot exceed eight characters.
Each variable name must be unique.
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Record: A case can have data on more than one line. The record number indicates
the line within the case where the variable is located.

Start Column/End Column: These specifications indicate the location of the variable
within the record. The value for the variable can appear
anywhere within the range of columns.

Data Type: Select a data type.

For this problem, the following is a list of the required information.

Name Record Column Locations Data Type

Player 1 1-3 Numeric as is
Height 1 4-7 Numeric as is
Weight 1 8-12 Numeric as is

When all information is added for a variable, click Add. This will enter the record
number, start and end columns, variable name, and data type onto the Defined
Variables list.

Once all variables are defined, click Browse to specify the name of the file to be read.
This will open the Define Fixed Variables: Browse dialog box. Change the path name
to your home directory and open the SPSS folder. This is where the file to be opened
should be.

Select nba.txt and click Open. The Define Fixed Variables dialog box will be returned.

Click OK. This will close the Define Fixed Variables dialog box and will open nba.txt
in the Data Editor.

Window Output

Untitled - 5P55 Data Editor

M[=]E3

File Edit “iew Data Transform  Statistics Graphs  Utities  Window  Help
sa|s| = o L el ) Fe Slwn el
1:player ‘ﬂ ﬂ
player height | weight var var var var var
1 1 73 162
2 2 81 225
3 3 80 241
4 4 73 190
5 5 76 184
6 B 77 205
7 7 80 250
;I_lﬂ a a2 260 ﬂll
|SPSS Processor is ready | | A
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» Tutorial 3: Opening an Existing SPSS Data Set

1. Select Open from the File menu. This will open the Open File dialog box.

1
Open File 7]

Look in: | Iff‘l E EE

Packages

Folariz

w35

w3, old
File name: I Open I
Files of type: ISF'SS [*.zav) j Paste |

Cancel |

2. From the Files of type drop-down list, select .sav.
3. From the Look in drop-down list, select the appropriate drive where the file is located.
4. In the File name box, type in the name of the file to be opened.

5. Click Open.
» Tutorial 4: Printing a Data Set

1. Highlight the data that will be printed. To print all of the data, ignore this step and
continue to step 2.

2. Select Print from the File menu. The Print dialog box opens. Change the options where
appropriate.

Print Untitled | X|
Frinter:  lip_307E @& hume on
 Selection
= Cancel |
LCopies: I‘I_ Setup... |

3. Click OK.
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Generating Descriptive Statistics in SPSS

________________________________________________________________________________________________________________________________|]
The following tutorials will demonstrate how to generate descriptive statistics in SPSS.

> Tutorial 1: Mean, Sum, Standard Deviation, Variance, Minimum Value,
Maximum Value, and Range

When generating these statistics, the Data Editor must be open with the appropriate data set
before continuing.

Problem

Using the data in the file nba.txt that is located in ~/SPSS/, determine the mean, sum,
standard deviation, variance, minimum value, maximum value, and range for height only.

Solution

1. From the Statistics menu, select Summarize. From the Summarize drop down menu,
select Descriptives. This will open the Descriptives dialog box.

Descnpllves B
Wariable[=]:
;4

e |
weight Easte |
Reset |

Cancel |

Help |

™ Save standardized values as variables Options... |

2. Inthe variable list, select the variable height. Left click on the right arrow button between
the boxes to move this variable over to the Variable(s) box. To calculate statistics for
many variables, simultaneously add variables to the Variable(s) box.

3. Click on the Options button. This will open the Descriptives: Options dialog box.

Descriptives: Dptions | X|
P Fm
—Dlspersmn% Cancel |
¥ Std. devigtion M Minimum

- - Hel
¥ Yariance I+ | Magimum —DI

[~ SE mean
r— Distribution
™ Kurtosis ™ Skewness
r— Digplay Order
& Wariable list
" Alphabestic

" Asending means

" Descending means

Click on mean, sum, standard deviation, variance, minimum value, maximum value, and
range.

Click on the Continue button when done.

17



4. Click OK. The Descriptives dialog box closes and SPSS activates the Output Navigator to

illustrate the statistics.

Window Output

g Output] - SPSS Output Navigator =] E3
File Edit “iew Insert Faormat Statistics Graphs  Utilties “window Help
(0S8R | = | D=k 2| & |
e[| +|-| @O *[=8]
E--{E] SPSS Output e =
=& Deseriptives =+ Descriptives
~+[E] Tile
o [y Metes
| g Descriptive Statistios Descriptive Statistics
Std.
M Range Minimum | Maximum Sum Iean Deviation Variance
HEIGHT 411 28.00 53.00 91.00 [ 32558.00 T9.2165 3.8502 14.824
Walid M
listwise) an

o

H_|SF'SS Processor is ready

%

> Tutorial 2: Correlation

Two or more variables may be included in a correlation matrix. When generating the
correlation matrix, the Data Editor must be open with the appropriate data set before

continuing.

Problem

Using the data in the file nba.txt that is located in ~/SPSS/, determine the correlation between

a player’s height and weight.

Solution

1. From the Statistics menu, select Correlate. From the Correlate drop down menu, select
Bivariate. This will open the Bivariate Correlations dialog box.

- Blvanale Comrelations

h.-u:hr Wariables:
player
weight

— Corelation Coefficient
W Pearson [T Kendal'stawb [ Spearman

— Test of Significance

& Two-tailed " Onetailed

V¥ Flag significant comelations

Reset

Cancel

LLLEI .

Help

i

Options

2. In the variable list, select height and weight. Left click on the right arrow button between

the boxes to move a variable over to the Variable(s) box.

3. Select the type of correlation coefficients that will be generated.

Pearson.

In this case, use

18




4. Select the test of significance to be used. In this case, use two-tailed.
5. Check mark the Flag significant correlations box.

6. Click on the Options...button. This will open the Bivariate Correlations: Options dialog
box.

Bivariate Comrelations: Options

r~ Statistic:
r eanz and standard : Cancel |

™ Cross-product deviations and covariances
Help |

— Mizsing WV alue:
% Exclude cases paiwise

' Exclude cases listwize

To display the mean and standard deviation for each variable, select Means and
standard deviations. In this case, this option is not used.

To display cross product deviations and covariances for each pair of variables, select
Cross-product devations and covariances. In this case, this option will not be used.

When done, click the Continue button.
7. Click OK. The Bivariate Correlations dialog box closes and SPSS activates the Output

Navigator. The correlation coefficient for each pair of variables is displayed. The number
of cases appears at the bottom.

Window Output

§% Output] - SPSS Output Navigator
File Edit “iew Insert Format Statistics  Graphe  Ublities  Window Help

= SR & B | 5=k @ & ¢
e[ F= mE ==

=] SPSS Output - |
o @ Coreltions = Correlations

(] Title
Motes
L& Correlstions Correlations

HEIGHT WEIGHT

Pearsan HEIGHT 1.000 856
Carrelation  ywWEIGHT 5564 1.000
Sig. HEIGHT . .noo
(2-tailed) WEIGHT oo .
M HEIGHT 411 LAR
WEIGHT 411 411

**. Correlation is significant at the 0.01 level
(2-tailed).

4 |

[¥ [5P5S Processar is ready |

?Il‘l;l
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Generating Graphical Statistics in SPSS

The following tutorials introduce how to create scatter plots, histograms, stem and leaf plots, and
box plots using the SPSS Graphs menu located on the Data Editor menu bar.

» Tutorial 1: How to Generate Scatter Plots
Problem
Using the data in ~/SPSS/nba.txt, create an x-y plot of a player’s weight versus height.
Solution

1. From the Graphs menu, select Scatter... This will open the Scatterplot dialog box.

Scatterplot E3

Simple b atrix Cancel |
P Overlay 30 Help |

2. Select the Simple icon and click Define. This will open the Simple Scatterplot dialog box.

i Simple Scatterplot

¥ s
\l?\!:f;:t Easte
2 s |
I—""S— Beset
Cancel |
Set Markers by: Help |
Label Cazes by:
— Template
™ Use chart specifications from:
Eiler |
Titles... | Options... |

3. From the variable list, select weight. Left click on the right arrow button between the
variable list and the Y Axis box to move the variable, weight, to this box.

4. From the variable list, select height. Left click on the right arrow button between the
variable list and the X Axis box to move the variable, height, to this box.

5. Click on the Options... button. This will open the Options dialog box.

Dptions

— Migzing Walue:

' Exclude cazes listwise

Cancel

==
Help |

) Evclude cases wanable by variable

™ Display groups defined by missing values

™ | Wisplay chart with case [atels
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To display a report of missing values, select Display groups defined by missing values. In
this case, this option will not be used.

When done, click the Continue button.

6. To display titles, subtitles, or footnotes on the histogram, click on the Titles... button. This

will open the Titles dialog box.

Titles E3
- Titl CantifLe I
Line 1: |
Cancel
Line 2 I _I
Help
Subtitle: |
— Foolnote
Line 1: I
Line 2: I

In the Line 1 box, type “Scatter Plot Height vs. Weight”.

When done, click the Continue button.

7. Click OK. The Simple Scatterplot dialog box closes and SPSS activates the Output

Navigator.

Window Output

g% Output] - SP5S Dutput Navigator M =] B3
File Edit Miew Insett Fomat Statistice Graphs Ublities Window Help
=[RSk »| B o| D=k 9f &
D EEEEEER]
- {&] =Pss output -]
E»@ Graph Graph
=) Title

[ Metes

|

400

Scatter Plot of Height vs. Weight

300«

200 o

WEIGHT

100

B

70 &0 a0

HEIGHT

4 items selected (1 hidden/collapsed)

| ¥ | SPS5 Processor iz ready |
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» Tutorial 2: How to Generate a Histogram
Problem
Using the data in ~ /[SPSS/statdata.txt, create histogram of per capita income.
Solution

1. From the Graphs menu, select Histogram... This will open the Histogram dialog box.

\ Histogram

enerqy Wariable: v

ExpEnsEs -

income Easte |

infant

labour Template Beset |

state

tuiticn ™ Use chart specifications from: Cancel |

File:s.. | Help I

™ Display normal curve Titles... |

2. From the variable list, select income. Left click on the right arrow button between the
variable list and the Variable box to move the variable, income, to this box.

3. Select Display normal curve box to show a normal curve on the histogram.

4. To display titles, subtitles, or footnotes on the histogram, click on the Titles... button. This
will open the Titles dialog box.

- Title Continue I

Line 1: I
Cancel

Line 2 | TI

elp |
Subtitle: I
— Footnote
Line 1: I
Line 2 I

In the Line 1 box, type “Histogram of Per Capita Income”.
Click on the Continue button when done.

5. Click OK. The Histogram dialog box will close and SPSS activates the Output Navigator
to display the histogram.
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Window Output
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» Tutorial 3: How to Generate a Stem and Leaf Plot
Problem
Using the data in ~ /[SPSS/statdata.txt, create a stem and leaf plot of per capita income.
Solution

1. From the Statistics menu, select Summarize. From the Summarize drop-down menu,
select Explore... This will open the Explore dialog box.

i Explore | X|

Dependent List: ar
ENpenses -
income Easte |
infant =

labiour Beset |

state Factor List:

tuition EE— Cancel |
Help |

' Both  Statistics ¢ Plots §tatistics...| Plats... | DOptions... |

Label Cazes by:

— Diizplay

2. From the variable list, select income. Left click on the right arrow button between the
variable list and the Dependent List box to move the variable, income, to this box.

3. Click on the Statistics... button. This will open the Explore: Statistics dialog box.

23



Explore: Statistics

V1
Lonfidence Interval for Mean: |95_ %
™ M-estimators
™ Outliers
™ Percentiles

Eontinuel Cancel | Help |

To display descriptive statistics, select Descriptives.

To display maximum likelihood estimators, select M-estimators.

To display cases with the five largest and smallest values, select Outliers.
To display percentiles, select Percentiles.

In this case, none of these options are used.

When done, click on the Continue button.

4. In the Display area, select Plots. This will display the specified plot only (i.e. no statistics
are given).

5. Click on the Plots... button. This opens the Explore: Plots dialog box.

Explore: Plots
— Boxplat; Descriptive
V' Stem-and-leaf z |
ancel
¢ Dependents together | [ Histogram _I
" None Help |

™ Momality plats with tests

— Spread vs. Level with Levene Test
' Mone

" Power estimation

" Transformed Power:INaturaI log 'l

' Untransformed

Ensure that the Stem-and-leaf box is selected.
Click on the Continue button.
6. Click on the Options button. This will open the Explore: Options button.

Explore: Dptions

Missing Yalues—————

o Cancel
" Exclude cases painwise _I
" Report values Help |

To exclude cases that have missing values for any of the variables used in any of the
analyses, select Exclude cases listwise. In this case, this option is used.

To exclude cases that have missing values for either or both of the pair of variables in a
specific correlation coefficient, select Exclude cases pairwise.
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However, to treat missing values as a separate category, select Report values.

Click the Continue button when done.

7. Click OK. This will close the Explore dialog box and SPSS activates the Output Navigator

to display the stem and leaf plot.

Window Output
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» Tutorial 4: How to Generate a Box Plot
Problem
Using the data in the file, ~ /SPLUS/statdata.dat, produce a boxplot of per capita income
Solution

1. From the Graphs menu, select Boxplot... This will open the Boxplot dialog box.

Boxplot E3

gsh|| Simele

Cancel |
@ #| Clustered |
Help

— D'ata in Chart &re

' Summaries for groups of cases
" Summaries of separate varables

2. Select the Simple button.
3. Select Summaries of separate variables in the Data in Chart Are area.

4. Click on the Define button. This will open the Define Simple Boxplot: Summaries of
Separate Variables dialog box.

i Define Simple Boxplot: Summaries of Separate ¥__.

energy Boxes Represent: K

expenses infant

incame Paste

labour —

state Beset

tuition -
Cancel

Help

Label Cases by:

A

5. From the variable list, select income. Left click on the right arrow button between the
variable list and the Boxes Represent box to move the variable, income, to this box.

6. Click on the Options... button. This will open the Options dialog box.
Dptions

— Migzing Walue:

%) Exclude cases listnise

. . Cancel
) Explude cases wanable by variatle

Help

dd

V' Display groups defined by missing values

= | Display chart with case labels

To display a report of missing values, select Display groups defined by missing values. In
this case, this option will not be used.

When done, click the Continue button.
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7. Click OK. This will close the Define Simple Boxplot: Summaries of Separate Variables
dialog box and SPSS activates the Output Navigator to display the box plot.

Window Output

f Output] - SP55 Output Navigator _ O] x|
File Edit Yiew Insett Fomat Statistice Graphs Utilities  \wWindow Help
=(@|&[R | = - Ok @ & |
)3 ==] @] z=e]|
=] s outout % Explore =l
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=) Title
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IMCOME 50 | 100.0% [ 0% 50 | 100.0%
40000
o
30000
20000
10000 |
H= kil
INCCOME
<] | _'IJ
| W [EPSE Processor is ready | i

27



Statistical Models in SPSS

» Tutorial 1: Linear Regression
The Regression submenu on the Statistics menu of the Data Editor provides regression
techniques. The following tutorial will introduce how to perform linear regression using SPSS.
The output contains goodness of fit statistics and the coefficients for the variables.

Problem

Using the data in ~/SPSS/nba.txt, compute a least squares regression line to investigate if a
player’s height can predict his weight.

Solution

1. From the Statistics menu, select Regression. From the Regression drop down menu,
select Linear... This will open the Linear Regression dialog box.

i Linear Regression
Dependent m
player I— -

weight Easte I

Plexious | Black 1 of 1 et I Bleset |
Independent(z]: ﬂl

- | Help |
Iethod: I Enter - l

Selection Variable:

—
LCaze Labels:
I
WLS 3> | §tatistics...| Flats... | Save... | thions...l

2. From the variable list, select weight. Left click on the right arrow button between the
variable list and the Dependent box to move the variable, weight, to this box.

3. From the variable list, select height. Left click on the right arrow button between the
variable list and the Independent(s) box to move the variable, height, to this box.

4. Select the method the independent variables are entered into the analysis. From the
Method drop-down menu, there is a choice of enter, stepwise, remove, backward, and
forward. In this case, we will use the enter method.

5. To limit the analysis to a subset of cases having a particular value for a variable, enter
this variable into the Selection Variable box. In this case, this option is not used.

6. Determine the variable that will identify the points on plots. Select the variable and left

click on the right arrow between the variable list and the Case Labels box. In this case,
this option is not used.
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7. To display statistics, click on the Statistics... button. This will open the Linear Regression:
Statistics dialog box.

Linear Regression: Statistics

i~ Regression Coefficients— W Madel fit

™ R squared change

. Cancel |
™ Confidence intervals ™ Descriptives
™ Covariance matris ™ Part and partial corelations Help |

™ Collinearity diagnostics

r— Residual
™ Diurbin atzon
[" Cazewise diagnostics
&) [utliers outside |3_ standard|deyviations:
) bl cases

Select the appropriate statistics to be displayed and click on the Continue button when
done. In this case, this option is not used.

8. To display specific plots, click on the Plots... button. This will open the Linear
Regression: Plots dialog box.

Linear Regression: Plots
Carati |
Frevinus | Scatter 1 of 1 Hest | oninge
Cancel |
: x I— Help
*SRESID |
*SDRESID % I—

Lizts the dependent variable [DEPEMDMT] and the following

predicted and rezidual vanables: Standardized predicted values
[*“PRED). Standardized residuals [ZRESID], Deleted residuals
[FDRESID]. Adusted predicted values [FADJPRED], Studentized
rezidualz [FSRESID), Studentized deleted rezidualz [*SDRESID.

esidual Plats [ Produce all partial plats

ability plot

From the variable list, select the variable that will be displayed on the Y axis. Left click on
the right arrow button between the variable list and the Y box. Do this also for the X axis.
When done, click on the Next button. If more plots are needed, follow the same
procedure. In this case, this option is not used.

When done defining the plots, click on the Continue button.

9. To indicate which statistics should be displayed, click on the Save button. This will open
the Linear Regression: Save dialog box.

~ Predicted Value:  Residual
il " Unstandardized Cancel
I Standardized [ Standardized
I Adjusted [~ Studentized Help
I” S E. of mean predictions [~ Deleted
[ Studentized deleted
~Distances
™ Mahalanobis ~ Influence Statistice
" Cook's [~ DiBetals)
I Leverage values " Standardized DiBetals)

[~ DiEit
[ Standardized DFFit
[™ Covariance ratio

— Prediction Intervals
I Mean [ Individual
LCorfidence Interval: |35 F4

—Save to New File

™ Coefficient statisics ~ File.
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Select the appropriate statistics. To save the coefficient statistics, click on the box and
indicate the file to which you want them saved. In this case, this option is not used.

10. To indicate the stepping method criteria, click the Options... button. This will open the
Linear Regression: Options dialog box.

Linear Regression: Options | X|

r— Stepping Method Criteria T

Cancel
Entry: I Femaowval: I.‘ID

" Use F value Help

Ertr: |3.84 Eremoval |2 F1

V' Include constant in equation

& Use probability of F -l
e |

i~ Missing Y alues
& Exclude cases listwize
" Exclude cases painsise

" Replace with mean

Select the method to be used. When the selection is made, click on the Continue button.

11. Click OK. This will close the Linear Regression dialog box. SPSS activates the Output
Navigator to display the results of the analysis.

Window Output

§= Output] - SP55 Output Navigator HEE
File Edit Yiew Insett Fomat Statistics Graphs Utilities Window Help
38|87 S| B of @[k @ & ¢
e]o] +[ -] @lo] (e
=[] s outot ' Regression =l
E! Regression
=) Title
- Motes
@ Model Sumimary Model Summary
g siove Std. Etror
. Coefficient: :
@ Comticirts Adusted | oTte
hlodel R F Sguare F Sguare Estimate
1 8563 733 732 15.6474
A. Predictors: (Constanty, HEIGHT
ANOVAE
Sumof Mean
hodel Sguares df Square F Sig.
1 Regression 2744665 1 2744665 | 1120997 .oon2
Residual 1001401 409 244841
Total 374606.6 410
4. Predictors: (Caonstant), HEIGHT
b. Dependent Variahle: WEIGHT
Coefficients®
Standardi
zed
Unstandardized Coefficien
Coefficients ts
hiodel B Std. Errar Beta 1 Sig. =
1 (Constant) -309.103 15.918 -19.418 it}
HEIGHT 6.720 201 856 33.481 i}
4. Dependent Variable: WEIGHT l
<] | 3
[ W [EPSE Processor is eady | S
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» Tutorial 2: Analysis of Variance
Problem

Using the data in ~/SPSS/tellerl.txt, test if the mean number of customers served per hour by
each of the four tellers is the same.

Solution

1. From the Statistics menu, select Compare Means. From the Compare Means drop down
menu, select One-Way ANOVA... This will open the One-Way ANOVA dialog box.

+ One-Way AMOVA E3

Dependent List: A

teller -
Baste |
Reset |
Eancell

Factor: Help |

I

Qontrasts...l Postﬂoc...l Options... |

2. From the variable list, select num_cus. Left click on the right arrow button between the
variable list and the Dependent List box to move the variable, num_cus, to this box.

3. From the variable list, select teller. Left click on the right arrow button between the
variable list and the Factor box to move the variable, teller, to this box.

4. Click on the Contrasts... button. This will open the One-Way ANOVA: Contrasts dialog
box.

One-way ANOYA: Contrasts
I

£

[Esii]
Eresiaus | Contrast 1 of 1 et | ﬂl

Help

Coefficients: I
Ad |
[Ehange |
Eemove |

Coefficient Total: 0.000

egee: I Linear j Cantinue

To partition between-groups sum of squares into polynomial trend components, select
the Polynomial box and select the highest degree of the polynomial to be modelled. In
this case, this option will not be used.

To enter a numeric coefficient value for each level, click Add. However, the number of

coefficients must equal the number of groups or the analysis is not performed. Because
the levels in this problem are already numeric, this option does not need to be used.
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5. Click on the Post Hoc... button. This will open the One-Way ANOVA: Post Hoc Multiple

Comparisons dialog box.

One-way ANOYA: Post Hoc Multiple Comparisons
—Eqg riances Assumed
In I~ SHK I %aller-Duncan
I~ Bonferoni I~ Tukey TupelTpei | Erran Hatio |1DD
I~ Sidak I Tukey'sb [~ Dunnett

™ Scheffe [~ Duncan Lanitral Cateqnn: I Last ¥ l

I~ B-EGWF I Hochberg's GT2 Test
™ REGW O [~ Gabriel ) Zsided € < Contrall £ 5 Eonfrol

— Equal Wariances Mot Assumed
I~ Tamhane's T2 [ Dunnetts T3 [ Games-Howel [~ Dunnetts C

Significance level: I.DE

Eontinuel Cancel | Help |

If equal variances are assumed between the different factor levels, select the type of
comparison method to be used.

If equal variance are not assumed between the different factor levels, select the type of
comparison method to be used.

To get a description on each of the methods listed, right click on the word. A description
window will appear.

Click the Continue button when done.

Click on the Options... button. This will open the One-Way ANOVA: Options dialog box.

Dne-Way ANOYA: Options
~Statistics——————————————
[ |
hy-of-variance ﬂl
Help |

— Missing Y alue:
' Exclude cases analysiz by analysis

" Exclude cases listwize

To display descriptive statistics, select Descriptive in the Statistics area. In this case,
select this option.

To exclude cases that have missing values for the variable involved in that test, select
Exclude cases analysis by analysis. In this case, select this option.

However, to exclude cases that have missing values for any of the variables used in any
of the analyses, select Exclude cases listwise.

Click the Continue button when done.
Click OK. The One-Way ANOVA dialog box closes and SPSS activates the Output

Navigator. The means of the dependent variable for each category of the independent
variable can be found under "Descriptives".
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Window Output
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Appendix A: Data Files

o City Data

This data set, called citydata.txt, includes prices of selected products for 200 selected cities
across the U.S.

C1
C2
C3
C4
C5

C6
C7

C8
C9

City number

Price of T-bone steak per pound

Price of half-gallon carton of whole milk

Price of 2-litre Coca-Cola bottle, excluding any deposit

Monthly rent of an unfurnished two-bedroom apartment,1-1/2 or 2 baths, approximately
950 square feet

Purchase price of 1800-square foot new house, on 8000-square foot lot in urban area
with all utilities

Monthly telephone charges for a private residential line

Price of one gallon regular unleaded gas, including all taxes

Average cost per day of a semiprivate room in a hospital

C10 Price for a woman’s shampoo, trim, and blow dry
C11 Price of dry cleaning, man’s two-piece suit
C12 Price of Gallo Chablis blanc wine, 1.5-litre bottle

Cc1 C2 C3 C4 C5 C6 C7 Cs8 C9 C10 C11 | c12

1 564 | 158 |1.39 | 556 129750 24.02 1.171 | 436.33 21.17 6.10 | 5.39

2 597 | 146 |[1.16 | 410 123450 22.06 | 1.287 293.67 21.90 | 6.23 | 5.69

3 446 | 153 | 122 | 410 107342 23.10 | 1.263 | 415.75 2149 | 547 | 4.96

4 598 |[135 |1.05 | 468 113920 23.07 1.227 | 352.50 16.40 | 5.75 | 6.16

5 567 | 142 |111 | 426 116125 17.87 1.222 290.00 1850 | 6.10 | 5.59
Q State Data

This data set, called statdata.txt, includes information of different variables for 50 states in the

u.s.
Cl1 State number
C2 Average tuition and fees (in dollars) for in-state residents at public college, 1995-96
C3 Female labour force participation rate (in percent), 1995
C4 Estimated 1996 spending (in millions of dollars) by states
C5 Per capita income (in dollars), 1995
C6 Per capita energy expenditure (in dollars), 1993
C7 Infant mortality rate (in percent), 1993
C1 C2 C3 C4 C5 C6 C7
1 2234 55.3 4235 19181 2092 10.3
2 2502 66.4 2483 24002 3085 8.2
3 1943 59.6 4562 20489 1871 7.6
4 2062 58.4 2583 18101 2100 10.0
5 2918 56.5 44246 24073 1564 6.8




Q NBA Data

This data set includes, called nba.txt, information on the heights and weights of NBA players

who were on the rosters of NBA teams at the beginning of 1996-1997 season.

Cl1 Player number
C2 Height (in inches) of a player
C3  Weight (in pounds) of a player
C1 C2 C3
1 73 162
2 81 225
3 80 241
4 73 190
5 76 184

Q Teller Data

This data set, called tellerl.txt, includes information on the number of customers that a teller

serves at a bank.

C1
C2

Teller number
Number of customers

Cl

C2

19

21

26

24

NP PRk

18

35



